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1 Function and area of use
This Start Up document describes the necessary steps to be taken when configuring Modbus
TCP with Crevis I/O in a Nexto system.

2 About this Start Up document
This Start Up document should not be considered as a complete manual. It is an aid to be
able to start up a normal application quickly and easily.
In this document the following software and hardware has been used.
Software
 BCS Tools 1.31
Hardware
 Beijer Electronics NX3010 (CPU)
 Decentralized I/O (Crevis I/O)

This document and other Start Up documents can be obtained from our homepage.
Please use the address manual@beijer.se for feedback on our Start Up documents.
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4 Overview
This is the basic configuration. The communication between the NX3010 and the NA-9189
uses the built-in ethernet port of the NX3010.
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5 Configuration in BCS Tools
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5.1 Create a new project
Create a new project from the File menu.

Choose the path of where the project should be created and the standard template.
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Choose the cpu, rack and power supply model.
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Choose the project profile, in this case the basic is being used.

In the Basic project profile, the application has a user task from the Freewheeling type called
MainTask which executes the program in a continuous loop (with no definition of cycle time)
with priority fixed in 13. This task is responsible for the execution of a single programming
unit POU called MainPrg. It is important to stress that the cycle time can vary according with
communication task quantity used, as in this mode, the main task is interrupted by
communication tasks.
This profile allows the inclusion of two interruption tasks with higher priority which can
preempt the MainTask at any moment: the task called ExternInterruptTask00 is an
interruption task from the Extern type with priority fixed in 02; the task called
TimeInterruptTask00 is an interruption task from the cyclic type with priority fixed in 1.
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For details about the other profiles refer to the CPU User’s manual.
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Choose the prefered programming language for the freewheeling task.
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Choose the prefered programming language for the interrupt tasks.
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5.2 Configure the IP address of NET1 interface
When the wizard is completed the following view appears, this is where the hardware
configuration of the system is made. In this start up we will use the following IP adresses:
NX3010 = 10.101.221.52, NA9189_1 = 10.101.221.53, NA9189_2 = 10.101.221.54

KI_eng.dot, 070221

Double-click the NET1 icon in the project tree and enter the IP details of the NX3010.
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5.3 Configure the IP address of NA-9189
Factory settings
IP-address 192.168.123.1
Subnet mask 255.255.255.0
Default Gateway 192.168.123.254
The addess can be changed in two ways.


The basic way is by using ARP commands from the command promt. This is
explained further down.



The most intuitive way to change the addresses is to use the "Bootp server tool" in
the software "IO Guide Pro", currently Windows XP is recommended to use.

To setup using ARP commands follow these steps. Note! The IP can only be changed to
another within the same subnet.
Command Prompt
>ping 192.168.123.236 //current IP address
>arp -a //view Ethernet physical address
>arp -d 192.168.123.236 //delete arp table
>arp -s 192.168.123.237 00-14-F7-00-00-00 //assign static arp table with new IP address
//”00-14-F7-00-00-00” is Ethernet Address (See Adapter Label)
>ping -n 1 –l 741 192.168.123.237 //assign new IP address
>arp -d * //clear all arp table
>ping 192.168.123.237 //check response of adapter new IP address
New IP-Address setup.
IP Address = 192.168.123.237
Subnet Mask = 255.255.255.0
Gateway = 192.168.123.254
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To setup the IP address using IO Guide Pro follow these steps:


Start IO Guide Pro



In the "Tools" menu, select "Bootp server".



Click the "Add New Device" button at the bottom.



Enter the requested parameters. (the MAC address is printed on the node module)



Click Ok, close down the Bootp tool, and try to ping the unit.



Now you can create a new project in IO Guide Pro using the NA-9189 bus module.
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Run "Autoscan" in IO Guide Pro to receive the configuration. (the green "antenna"
icon sown belowe)



You can now check and monitor the NA-9189 in IO Guide Pro.
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5.4 Add the Modbus Client device
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The next step is to insert the Modbus TCP client device on the NET1 interface. This is done
by right-clicking the NET1 port and choose Add device and select the Modbus Client
device.
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5.5 Add the Modbus TCP slave
To add the Modbus TCP slaves double-click the newly inserted device, Modbus_Client,
then click the Add button and enter a name and the IP address of the slave. For further
details about other settings refer to the cpu User’s manual.

5.6 Data mapping in NA-9189
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The NA-9189 module maps all data from/to the I/O modules mounted to one input and one
output area.
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Input data is mapped as both holding register and coils and the same applies for the output
data.

The two NA-9189 used in this example are equipped with the following modules.
NA-9189 | ST-3702 | ST-1218 | ST-2744
ST-3702 = 2 RTD inputs
ST-1218 = 8 DI
ST-2744 = 4 DO
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The address mapping can be checked by using IO Guide Pro from the View menu and select the
View address map option.
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Another way to check the mapping is to use a web browser and connect to the NA-9189.
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Click the Expansion Module button to get more details of the mapping.

It’s recommended to always install analog modules before digital to avoid a possible byte
separation of a 16bit input word.
The following is a example of a byte separation:
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NA-9189 | ST-1218 | ST-3702 | ST-2744
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5.7 Configure the data mapping of the Modbus TCP slave
Click the Add button to configure how to access the NA-9189. The most efficient way is to
use the Modbus function Read/Write Holding register, therefore Holding register is chosen.
Click OK to verify the setting.
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The next step is to configure how many holding register to read and write and from what
address. The NA-9189 input area starts at address 0 and the output area starts at address
2048. The NA-9189 has 0-based addressing which means that the lowest address is 0, while
the Nexto system is 1-based which means that the lowest address is 1. This will give us a
offset with 1 when addressing a NA-9189.
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Function = Read/Write
Slave address = Not used when using NA-9189, use default value
Polling = Set the desired polling rate
Mapping Diagnostics Area = This is the IEC adresses that will contain diagnostics about
the mapping function, refer to Cpu User’s manual for more details.
Read Settings
Read Data Start Address = Starting address to read from NA-9189 (because of the address
offset address 1 will be address 0 in NA-9189)
Read Data Size = Number of Holding registers to read.
Read IEC Variable = The IEC address to map the read Holding registers.

Write Settings
Write Data Start Address = Starting address to write in NA-9189 (because of the address
offset address 2049 will be address 2048 in NA-9189)
Write Data Size = Number of Holding registers to write.
Write IEC Variable = The IEC address to map the written Holding registers.
Repeat the mapping for the other NA-9189. The IEC addresses used for the other NA-9189
is:
Read IEC Variable = 30040
Write IEC Variable = 30060
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The first NA-9189 only occupies from from 30000 – 30004 and 3020 – 3020 by creating
some “space” between the addresses future expansion will be easier.
The mapping is now complete.
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5.8 Create variables and connect to the IEC addresses
To get the Modbus data in user variables the variable needs to be connected to the IEC
address. In this example a new GVL is created named ModbusTCP_IO.
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The relation between the Modbus adress in the NA-9189 to the user variable is according
the following table. This is the relation for the NA-9189_1
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This is the relation for NA9189_2.
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Screenshot of the created varibles connected to the addresses above.
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Compile and download of the project
This chapter describes how to compile and download the project.

6.1 Compile of the project
When the configuration has been completed the project has to be compiled. To compile the
project click the menu Build\Generate code.

Once the code generation has been successful it’s time to download the project.

6.2 Download of the project
To download the project the accesspath to the cpu must be configured. The access must be
made via the built-in ethernet port of the cpu. The default IP-adress of NET1 is 192.168.15.1

In case of using the NX3020 or NX3030 with two ethernet ports NET1 must be used for
communication with BCS Tools.
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Double-click the device in the project tree to access the communication settings.
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Choose the Scan Network option or add the device manually by clicking the Add device
button.

If the cpu is found on the network it will be shown in the list.

If cpu is unavailable an error message will be shown.
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When the cpu has been found click the button Set active path. The cpu in the list will be
bold to indicate that this is the path that will be used when an online action is made.
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To download the project click the Login button and click the Yes button.

If the cpu is empty or if there is another project running BCS Tools will prompt the user to
confirm the download. The cpu will be stopped and the older project will be overwritten.

The progress of the download can be found down in the left corner of BCS Tools.
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When the download is completed the cpu is in STOP state. To set the cpu into RUN state
press the run button. No reset or power on/off is necessary after the download even if
parameters has been changed.
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The status of the cpu and the Modbus TCP driver can be found in BCS Tools. To see status
of each slave the diagnostic variables must be used.
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If a Modbus TCP slave is missing in the network this can be read by the diagnostic variable.
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7 Communication interlock signal
For every module mounted in the Nexto system, BCS Tools creates diagnostic structures.
These structures contains detailed information of the cpu, communication module, Profibus
DP slave etc.
For more details about these structures refer to the User’s manual of the specific module or
the CPU User’s manual.

7.1 Example of how to create a communication interlock signal
This is an example of how we can create a Comm_OK signal. When any of the configured
slaves stops responding to the master this flag will be set to FALSE.
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There is also flags available for independent communication control of each slave.

www.beijer.se

24 (28)

BCS Tools/Nexto - Modbus TCP and Crevis I/O

KI00350 2013-08

8 Troubleshooting
To troubleshoot and get diagnostics from the Nexto system there are several possibilities
available.


Diagnostics structures, created automaticly in BCS Tools.



The OTD, One Touch Diagnostics function and LED:s.



Diagnostics via the WWW page in the cpu.

8.1 Diagnostic structures
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When the Modbus TCP driver is inserted a data structure is created automaticly located in a
list named Diagnostics. This list will be populated with diagnostics structures for all
hardware inserted in BCS Tools.
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The diagnostics variables DG_ModbusTCP_Communication.bRunning is a variable
indicating that the ModbusTCP driver is running with no errors.

The diagnostics variables DG_NA9189_1_Mapping_000.bCommOk is a variable indicating
that the communication with the slave NA9189_1 is running with no errors.
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The diagnostics variables DG_NA9189_2_Mapping_000.bCommOk is a variable indicating
that the communication with the slave NA9189_2 is running with no errors.
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The following is an example when more data is accessed then available in NA9189_2.
The diagnostics variables DG_NA9189_2_Mapping_000.bCommError is TRUE, the
DG_NA9189_2_Mapping_000.eLastErrorCode is reporting ERR_EXCEPTION and the
DG_NA9189_2_Mapping_000.eLastExceptionCode is reporting
MAPPING_NOT_FOUND.
When the error is present the DG_NA9189_2_Mapping_000.wCommErrorCounter will
increment for every telegram sent to the slave.

The diagnostics variables DG_NX5001.tMstStatus.abySlv_State.bSlave_xx are variables
representing the online status of the configured slaves in the project.
For example DG_NX5001.tMstStatus.abySlv_State.bSlave_3 is a Profibus DP slave with
station number 3. The value TRUE = online and FALSE = offline.
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For more information about the structures refer to the User’s manual of the cpu.
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8.2 OTD and LED information
Note! When using the Modbus TCP driver the diagnostics is only available via the
Diagnostic structures.

8.3 Diagnostics using the Diagnostic Explorer in BCS Tools
Note! When using the Modbus TCP driver the diagnostics is only available via the
Diagnostic structures.

8.4 Diagnostics using the web browser
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Note! When using the Modbus TCP driver the diagnostics is only available via the
Diagnostic structures.
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